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Session 2 

Book Design 101  

Journal Cover Design 

When it comes to cover design… 
๏ your overall design MUST be professional. Remember the “Three Second” Rule: 

You have three seconds to convince someone that your book is awesome enough 
that they should read the description of your book if browsing online or to turn it 
over and read the back cover description if browsing in person. You will lose them 
immediately if your journal cover is not professional

๏ Title must be readable… and short. Sometimes sub-titles are long and even made 
playful by the publisher, but the title needs to be short. If you create a 20 word 
sentence on the cover of your book, no one is going to buy because no one is 
going to read the title. Simplicity is not easy, but it is important so work at it. 
Remember the three second rule!

๏ Use no more than three fonts/styles, preferably two. For my coloring book journals, 
I use one font on the title, another on the sub-title and the same one in bold for my 
name. That means three styles and two fonts. You can use one font and use color 
or different styles (bold, all caps, italics, etc.) to set apart different component parts 
of your cover.

๏ Choose color carefully. Color theory is powerful and it will be worth it to you to 
study more about it. The bottom line is this: What do you want people to do or to 
feel in using your journal? If you want them to experience a calming effect, choose 
a blues and greens color palette. If you are doing something environmental or with 
pets, earth tones are good. If you want them to take action, use red, a power color. 
Red is the second color that hits the retina of the eye, about a millisecond behind 
blue. The more red you use, the more your audience reacts to it (by the way, red 
also induces hunger, so keep it away from diet books but you might want to use it 
in recipe books and foodie journals). Go to a bookstore and look in a section 
related to your niche. What colors are being used on the covers? Finance books, 
interestingly, don’t use a lot of green. Take notes about these things and research 
the reason in color theory.
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Cover components: what goes where 

On the front:

✓ Title

✓ Author Name (optional): if you are doing a simple lined book, there is no need; but if 
you are doing a journal the way we are learning here, by all means, you want to 
brand yourself and use your author name on the cover.

✓ Images/Illustrations (optional): not required but can help to get viewer’s attention. 
They can be powerful and convey a lot more than lines can.

On the back:

✓ A hook or phrase: the lure that gives a customer reason to bite; a phrase that in a 
nutshell tells the viewer the benefit he/she is going to get from buying your journal

✓ Description/bullet points: if your journal has non-fiction and/or education 
components, bullet points highlighting what the viewer will learn can help

✓ Publisher name (optional)

✓ ISBN/Barcode: absolutely required if you want to sell your book.

✓ Author website (optional): use a website address that relates to your book focus and 
directs viewers to where you want them to go.

✓ Price (optional)

✓ Categories (optional): make your book look more professional if you have them 
there. They can be totally made up. For the most part, it is only large chain 
bookstores that have specific categories for their books. Use Amazon, or 
IngramSpark as a guide, and ask yourself where would you expect to find your book 
if you walked into a bookstore? Make up the category that makes sense.

✓ Endorsements (optional): not that important for most types of journals. If you are a 
major expert in your field, especially if a technical field, and want to boost your 
credibility by association to get people to follow you, then you may want to use 
reviews/endorsements.

✓  About the Author (optional): not important for the cover, especially if you have a 
page for this on the inside of the book.
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On the spine:

Not all printers print on the spine and most have a page limit (minimum) requirements 
in order to do so, but don’t forget this area. If your book is on a bookshelf either in a 
bookstore or someone’s home, this is what is showing.

✓ Title

✓ Author name

✓ Publishing company mini logo (optional) 

Images & Illustrations 

Where do you get images you can use?
๏ photopin.com is a website that searches Flickr images
๏ pixabay.com (just be careful because they have sponsored images at the top of 

their pages)
๏ openclipart.org 
๏ any paid stock photo site: all let you use their images on a book cover

Software 

Note: It came up in Q/A last session about the use of student versions of Photoshop. It is 
important to note that Adobe has changed its policy. In the past, owners of academic versions 
of Adobe software were prohibited from using that software for commercial purposes. That is 
no longer the case. Directly from Adobe’s website:

This means if your company purchased software for you or you use a business 
computer to run the software, you could get into trouble, but provided you are using 
your privately-owned (home) computer, you can use this software to create products 
for commercial purposes.
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You must meet eligibility requirements as specified by Adobe to get academic versions 
of Adobe software. This includes 

There are cheap ways to accomplish some of these design tasks, but if you are intent 
on designing products using cheap software, you won’t last long in the publishing 
business. This is a business and business requires investment for success. If you 
aren’t prepared to invest in a business, you need to consider another option for 
earning a living.

These days Adobe’s Creative Cloud makes it very inexpensive to have a full suite of 
top-notch design resources at your fingertips for $50 per month or $10/mo for 
Photoshop/Lightroom. A single app like InDesign is an additional $20 per month but 
for very little more than the cost of Photoshop + InDesign, you can have the entire 
Adobe Creative Suite of software including Photoshop, Lightroom, InDesign, 
Illustrator, Premiere Pro, Dreamweaver, Acrobat Pro and several other software apps 
plus numerous other benefits. There just isn’t a better deal when it comes to creating 
products for your business.
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Demonstration: Cover Design Using Photoshop 

1. Decide what size the journal is going to be. Standard size 
for the type of journal we are going to create is 8 x 10”

2. Photoshop > File > New, name the file > set up your cover 
dimensions. The cover will need a bleed (the color will run 
off the edge so that when paper is trimmed, the color is 
visible all the way to the edge of each cover). This bleed is 
1/8” or .125. 

For the height, total dimension is 10 + 1/8 + 1/8 = 10.25”

Width is a little more difficult. You have the front cover of 8” 
+ the back cover of 8” + bleed on both sides, a total of 1/4” 
plus the spine. You won’t really know your spine 
dimensions until you know the number of pages in your book. For the moment, we 
will plug in 1/2 inch because experience tells me that I am going to have a spine of 
about that size. So, the width is 8 + 8 + 1/4 + 1/2 = 16.75

Resolution = 300 pixels per inch

Color Mode is CMYK, the requirement for print. If you are ONLY doing an ebook 
cover, RGB is fine, but if you think at any time in the future you might ever do a 
book in print, set this as CMYK. All of your colors will be different between 
electronic and print versions — and possibly dramatically different — if you try to 
change from RGB to CMYK in the future. 

3. Once you create this new document, drag guides from left ruler and from top ruler 
to identify where your trim line will be — that place where the printer cuts off the 
bleed, 1/8” on all sides. Drag a guide line to the center (8.25) and then drag guides 
1/4” to either side of center to represent the spine. NOTE: if you are doing layout in 
InDesign, it will do the math for you. ;)

4. Choose images for your cover. You can take a high-resolution photograph of your 
own to use or use stock or public domain images. Search Photopin or another site 
for a cover image. Photopin allows you to check a box for commercial license to 
narrow your search to images that permit commercial use. Make sure that box is 
checked. NOTE: you will also see that there are sponsored images across the top 
of the page the same as with Pixabay. These are paid images so you may want to 
be careful to not click on those. If you don’t see something that appeals to you in 
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the design you want, try a different site like Pixabay or use a royalty-free 
purchased image from a site like shutterstock.com. When you find something you 
want to use, download the largest 
size to your desktop and continue 
downloading images you think you 
want to work with for your cover.

5. Photoshop > open downloaded 
background image > select all > 
edit > copy > go to your cover 
layout document > paste. Scale as 
necessary for your design, apply 
filters if desired > save. Repeat 
with any other images you want to 
use in your design. You will now have the basic image 
layout for your cover design (image right). 

6. Choose a font > add text for title, sub-title and any other 
cover text matching the colors to your background 
image(s). 

Remember two and not more than three fonts

Make sure to keep “breathing room” around your text. 
You don’t want your title too close to the spine because if 
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something was off in the printing process, it could mess up your title, so give it a 
little space around the words. 

Adjust text colors, font sizes, kerning (space between letters), etc. to get the look 
you want. 

Demonstration: Cover Design Using InDesign 

InDesign is a professional layout program and the process is so much quicker for me 
when using it.

1. Open InDesign > New Document > layout 
settings. In InDesign (ID), you input the 
size of your finished cover, input bleed in 
the bleed settings and the spine in the 
“gutter.” ID takes care of setting up the 
correct page size. Add margins to mark 
where your text should be placed to 
provide the “breathing room” we had to 
manually create in Photoshop. Columns 
should have been “2.” If you missed doing 
this in the initial setup, go to Layout > 
Margins & Columns > set to 2 (below). 
Width should be 16.5 (front + back + spine 
that we are making .5 for now)

2. I will go back to the Photoshop file where I laid out the cover. Turn off all layers 
except the background image where I added a pixelated filter effect > save as jpg 
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(which will save only this layer that is turned on) to the desktop. InDesign can read 
a file saved as .psd, the Photoshop format. But, because that is a large file, I want 
to save as .jpg. Now, back in ID, I can simply import or drag this image onto the 
layout for my background. Drag the image to the red/magenta lines which are the 
bleed lines and it is perfectly sized to my cover. This is one of the beautiful things 
about working with Adobe software. It is all designed to play nicely together. Save 
document to desktop.

3. Go back to Photoshop where I created the same Filter effects on the 
lightbulb and save a file of just the lightbulb the same as in step 2 but as 
a .png to preserve transparency. Drag lightbulb from desktop into the area 
outside the actual cover (or ID will try to fill the cover entirety with the 
lightbulb image) > resize as desired and re-position. The filter effect has 
been retained in the lightbulb > Save.

4. To add text in ID, select the Text tool and drag a box on the layout. This text 
box is where we can now type our text. Again, choose colors, fonts, styles, 
etc. for the text. Leading (space between lines of type) and kerning are much 
more accurately adjusted in ID.

5. I like the text the way I have done the title, but the “g” is fighting with the 
lightbulb (below left), so I want to put a drop shadow on it. First, go to the 
Swatches tool panel and make sure the “T” is selected or the software will 
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add the drop shadow to the [invisible] box that surrounds the text. Choose Effects 
> Drop Shadow > you can play around with the settings for the drop shadow. I 
have my own favorites for offsets and size but these might not work for you. Now, 
the “g” pops out from the lightbulb.

6. With the eyedropper tool (see below), I can select the yellow in the lightbulb, 
making it an active color. To add it to the swatches, click on the little yellow color 
box and drag into the swatches panel. However, this is rgb so click on the color 
and change to cmyk. Now I can select the word “idea” in my title and make it the 
same yellow to match the lightbulb. NOTE: you can copy/paste the text from 
Photoshop to ID the same as images.
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And now we have our 
front cover completed 
(check session 3 for the 
back cover design demo)

NOTE: if images look pixelated in ID, they probably are not. Right click on the 
image > Display Performance > choose High Quality Display to see what the 
image really looks like. ID is a memory hog and because of it, image appearance 
defaults to a fast or typical display to take less memory. That makes the image 
appear on screen as if it is pixelated or low quality.



Journal Interior Design 

Here are some things you need to keep in mind when planning for the interior design 
of your journal:

➡ The more creative you are in your design, the more sophisticated the software you 
will need.

➡ Page numbers or no page numbers? Some software makes it easy to add page 
numbers while other software doesn’t.

➡ Margins!!! If text is too close to the edges or falling into the middle, it is a dead 
giveaway that a book is self-published and created either by a graphic designer who 
doesn’t know specifics of book design or by someone who tried to do it on their own 
and doesn’t know what they are doing.

➡ Black and white vs color… You can do color inside and some printers do it, but for 
this type of book, it is unnecessary. Adding color pages will significantly increase the 
cost of printing. 

Software 

๏ BookWright
๏ PowerPoint
๏ Adobe InDesign

Demonstration: Bookwright 

BookWright is a Print-on-Demand printer owned by Blurb. They are expensive but the 
quality is superb both in color and black/white. Pricing has come down a bit since they 
partnered with IngramSpark, but it is still 
high and as a “middleman,” their value in 
the chain is not great considering you can 
go directly to IngramSpark. We will talk 
more about this later.

BookWright does have some great 
software for doing interiors. It is not a 
good choice for covers but for interiors, it 
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is a very good alternative to InDesign. The first thing you notice in the layout (pink 
area) is that the pages already have the built-in margin for you.

To use BookWright… 

1. Select to add a text container > drag a text box into your page at whatever size 
you want > click on this text box and a text dialog pops up for you to type your text. 
You can move this text container around on the page after you’ve typed in text.

2. Make lines & don’t make it hard. Here is my method for making lines: Hold down 
shift key + the hyphen and hold it until you get the line length you want; copy line > 
enter > paste. 

3. You can import other documents or photos into your layout. Say you want to add 
checkboxes. The best way is to go into your MS Word > new document > insert > 
symbol > symbol browser > drag checkbox to page > select > copy > go back to 
BookWright > create new text box > paste and adjust size of box > add text in font 
of your choice > copy line of text with box > enter > paste > change text. The 
software is going to give you a warning symbol when you do this because you are 
using a font that is not theirs and it doesn’t like that. Just “ignore all.” 

4. To add page numbers > select page number container icon (image below right) > 
specify where you want the page number to appear on the page and on what page 
“page 1” should start. This is important. You want page numbers to start on the 
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actual first page of the book, not on the title page or any of 
the front matter pages like dedication or copyright page. If 
you have created front matter pages in your document, you 
can specify which of these pages is the first real page of the 
document, in this example, page 3.

5. If you have created text boxes and decide you don’t want 
any of the text inside, click the box to activate it and click the 
trash can icon. If you want to eliminate the text box, click 
trash can again.

6. Say you want the text you’ve created to be on more than 
one page. For example, in a journal, many of the elements 
repeat from page to page. Right click on a container > copy 
container > go to new page > click on page > right click > 
paste container. This is the secret to making a book quickly!

7. File > Save as Test pdf > name > save

Postscript Note: Blurb no longer allows you to do a high-resolution download of your 
document that you can take to any printer as it used to do. The rules have changed 
and you have to pay to get this — one of the problems in not using true design 
software.
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Demonstration: PowerPoint 

Powerpoint gives you all the same kind of text and layout options as a basic page 
layout or BookWright. It is simple to layout an entire book right in PowerPoint. 

1. New Presentation > File > Page Setup > 8” x 10” > first page is book title / author 
name

2. Duplicate page and change text for each of the next pages in front matter > drag to 
re-position text as you want. Remember your margins!

3. Continue to copy page 1 and type new text, align text by dragging text box 
handles. Make lines exactly the same as we did in previous example. You can 
make a few and then copy / paste the text block to make more lines. As you move 
the text box of lines around in Powerpoint, holding the shift key down while moving 
will constrain movement to straight up and down (or left right) so you don’t lose 
your alignment.

4. Again, to make check boxes, use the same technique as we used in the 
BookWright demonstration.

5. If you are repeating a right and left hand page combination throughout an entire 
book or section of a book, select the two pages (left and right) > copy > paste > 
paste > paste… until you have your book pages completed.

6. File > Print > Save as .pdf > name > save and you have your book.
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Demonstration: Adobe InDesign 

1. File > New > New Book. I am creating a 
new book because this is how InDesign 
(ID) organizes everything. For instance, 
you can have different documents to 
separate book sections. Say you are 
writing a big non-fiction book and decide 
you want to move one chapter so it is 
printed before another. You just have to 
drag and drop that chapter and ID will 
repaginate and reorganize everything 
automatically for you.

2. New Document settings: 

Number of Pages: you can make this any 
number and you can start with just one 
and add pages as needed once inside the 

JOURNAL DESIGN BASICS - KRISTEN JOY SESSION 2, PAGE !17



document.

Facing Pages: if you want to show left and right pages side by side on your screen 
as they would be in an open book.

Paper Size: 8” x 10”

Margins: .375 all around; then, uncheck the little link icon (which causes all margin 
fields to change to the same thing when you make a change) and change the 
inside margin to .5. Recall I said margins are a giveaway that a book is not 
professionally published. The inside margin needs to be bigger so that when the 
book is bound, the text doesn’t “fall” into the binding. 

Bleed: none because this is the inside of the book, not the 
cover

3. Save and give this section of book a name (in our demo, I 
name it Frontmatter-IJ) > Open the Pages tool window (right) 
> click the add button to add a page. Note: page 1 will show 
up as a single page, not a facing page spread because books 
typically (always for fiction) start on the right page.

4. click add button in book tool window (see image below) to 
add this new section, Frontmatter-IJ, to the book > locate the 

file where you saved it on your computer > select it and it is added into the book. 
Once you create a document for the main body of the book and one for the back 
matter of the book, you can add these component parts the same way into your 
book. The more segmented you make the components in your book, the more 
flexibility you have to move things around later. In most journal designs, that may 
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not be necessary since the material typically repeats throughout the book. 
However, if you are doing something different, you will want to add a new 
component in your book layout for each unique section in your book so that you 
give yourself more flexibility.

5. Title Page: I’ve already done the cover and I want the inside title page to match. 
One of the beautiful things about using ID is that you can copy and paste from the 
cover into the title page here. Open cover > select all text boxes (we want 
everything except the background image) plus lightbulb (holding down shift while 
clicking on individual elements will select each of 
those) > copy > go back to Frontmatter-IJ, page 1 > 
paste > change text color to black (we made it 
white for the dark cover) so it shows up on the 
white page > in color swatches menu (right), 
change tint of the words “idea” and “for writers” to 
50% to get a 50% gray > change effects on 
“ultimate idea tracking journal” to make drop 
shadow white, higher opacity and blend mode of 
normal or screen (again, so “g” will pop against the 
lightbulb) > resize > reposition. Later, I will go back 
into Photoshop and change lightbulb to grayscale 
for title page because I am not printing in color, but 
right now, I am going to leave it alone. OPTIONAL 
but highly recommended, you can add your 
publishing company logo and name below the 
author name on the title page.
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6. Page 2, draw text box for copyright 
information, type “copyright” and then you want 
the copyright symbol: Type > Insert Special 
Character > Symbols > Copyright Symbol 
followed by the year and copyright owner 
name > new line: “First edition; First Printing” > 
new line: copyright text > new line: “ All rights 
reserved…” > new line: ISBN 

Use a simple font. I am using Myriad Pro here. I want the text to line up with the 
bottom margin. This is another thing using ID makes easy. Select text box > hold 
command/control b to get Text Frame Options dialog box > set alignment to 
“bottom” > OK and it auto aligns all the text to the bottom left margin.

7. Page 3: Dedication

8. Add page 4: Blank. Printing will require pages to be divisible by two and since all 
pages start on the right, we need a blank left 
page to end this Front Matter section of the 
book.

9. Save As “Body-IJ” (name of next section) to 
make a copy of this to edit for the next section. I 
already have the fonts the way I want them, so it 
is easiest to just duplicate this section and use it 
for the next one. Now you will see a warning 
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triangle icon in the book menu. This is because you saved this section outside the 
book when you did a Save As. Double click the Frontmatter-IJ file in the book 
menu to open it back up again > Save. NOTE: you could have just saved the file 
before doing the Save As at the beginning of step 9 to have prevented this 
warning.

10. In exactly the same way you initially added 
the Front Matter file to the book, click the 
Add (+) button in the book menu > 
navigate to and open the file you created 
via Save As in step 9 (Body-IJ) > select 
and open. Now, you will have two 
documents in your book menu. You can 
see how many pages are in each section 
to the right side of that section line.

11. Delete the pages with text on them in this 
copied file since you are going to make new pages in this section. To do the inside 
content, it is the same way as we did the cover earlier in this session. You drag 
text boxes into the page and type your text; and drag images into your page, 
resize, reposition, etc. 

12. Create Master Pages: ID has what is known as a “Master 
Page.” You can add more of these to create any unique 
repeating pages. The concept of a Master is that anything 
put onto a Master Page will show up on any document page 
that is built on that Master.  You can think of a Master as a 
template for a page and each page can be specified to use 
a particular Master or template you have created. So, for 
example, since a header and footer may be different on right 
and left pages (as a rule, they always are different in fiction 
books, for example), you would create a Master for the left 
page and a Master for the right page. Then you would add 
onto the left Master page the repeating content that should 
appear on all left hand pages and on the right Master all 
content that should appear on the right hand pages. Once 
the Master pages are set up, you simply identify which 
Master each new page should use as its template and 
everything on that Master will show up on the document 
page. In the “old days” of page layout software, if you 
wanted something on a bunch of pages, say a graphic of 
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some kind, you had to add it on every page. If you then wanted to change that 
graphic, you had to go back and change it on every page where it appeared. Not 
so with Masters. Now, anything you want to change on all the pages merely has to 
be changed on the relevant Master page to automatically apply those changes to 
every page using that Master. Brilliant! 

Adding Page Numbers: if you are using page numbers, Master Pages make it very 
easy. Once you create a Master Page for each of your left and right pages > on 
the relevant MASTER page, text tool drag to create a text frame > Type > Insert 
Special Character > Markers > Current Page Number > change font (Myriad Pro) 
and justify text in text box for the correct side of the page (left justify on left page, 
right on right page) > command/control b to bring up the Text Frame Options 
dialog and set your desired alignment position at bottom of text frame.

To place the page number on the opposite page, simply copy the text frame, select 
the other Master Page and paste > reposition as needed.

Yes, ID has a learning curve (if you use Photoshop, you are half-way there) and 
the set-up in ID takes a little longer and is more sophisticated than using Canva or 
PowerPoint, but if you want to move your design to the next level, this is the way to 
go. Once you have the setup complete, you will find it so much easier to adjust 
things in your layout than you would in any other software.

Fonts: the font used for my author name, American Typewriter, is going to be used 
as the heading font throughout my book. The font used for the copyright was a 
simpler font than either American Typewriter or Journal which was used for the 
title. Don’t forget the “no more than three fonts” rule. 

13. I will bring up the notes I took in Session 1 for 
what I wanted to put on my content pages and 
use as a reference for building out my pages. If 
you thought Master Pages were cool for creating 
page numbers, prepare yourself… here is where 
the beauty of Master Pages come in when doing 
a journal. On my right side MASTER page, drag a 
text frame (or I can go back to my title page and 
copy my name and paste it in here since I am 
using the same font for my body headings) > drag 
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ends of text frame from left to right margins. This will insure that the text is 
centered exactly between the margin lines. Type some text > Paragraph Menu > 
select the center alignment icon. NOTE: if you don’t see a menu like Paragraph 
Menu, go to Window in the top menu bar and locate that menu, select it and it will 
pop up on your screen.

Add lines and graphics just as we did in PowerPoint, etc. Remember whatever you 
put on your Master Page is going to show up on every page where that Master is 
applied. This is where your creativity gets to shine. You want to experiment and try 
new things with your layout.

Lines: you can do lines the same way we did them before with a shift plus hyphen 
held down across the page. When you include prompts, a more professional look 
would not have the prompt text sitting over a line but the first line would start after 
the end of the text. Creating this line with shift + hyphen can become a real pain if 
you go back and want to change the words — something that would naturally 
change where the text ended and thus require you to redo the line. A more 
advanced way to do lines is to use Tabs.

a. Type > Tabs to bring up the Tabs dialog box > set a right justified tab just short 
of the right margin

b. Leader is what is to fill the space between where the cursor stops and you hit 
“TAB.” Since I want it to be a line, I will type an underscore (shift + hyphen) in 
this box

c. Type text like “My idea came from” and hit the TAB key on your keyboard. 
Instantly, you have a line. This line is going to look different from the lines 
above that I drew using shift + hyphen because it is a different font size I am 
using in my text, but this is a different element, so I am okay with this. I could 
get very fancy and put a box around this or any other design element. Be 
creative and do a design that appeals to you (see image below).

14. To create another page layout for my book, the back side of the pages I just 
created (image below), I need a new Master. I can just duplicate the one I have 
and edit it rather than starting from scratch. 

15. Repeat the same process as above to layout the page(s) using copy and paste as 
much as possible to speed the process rather than starting each text block from 
scratch. 
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Check boxes: To make check boxes, Type > Glyphs > choose an empty box or 
circle. Glyphs are sets of characters or symbols that are specific to a font. If you 
are using a font that has a set of glyphs associated with it, you will get that 
selection in the glyphs panel dialog. Some fonts have a lot of glyphs and others do 
not. You can always type a different font name 
in the glyphs panel to bring up the glyphs for 
that font and give you more selection. On a 
Mac, Wingdings is usually a pretty good font 
for finding useable boxes, arrows, etc. Find 
something that appeals to you. Just remember, 
when you use a glyph from a different font, that 
font is now set on that line of type so when you 
begin typing text for your checkboxes, it will be 
in the same font as your glyph. Be careful to 
put this text back into the font you are using 
for text (e.g. Myriad Pro) so you don’t get a 
sloppy conglomeration of fonts in your book.

Repeating Text: With text that repeats such as “Due Date”: select text > right click 
> Paste in Place will put the copy of the text exactly over the text copied so they 
perfectly line up. Select the copy and use the down arrow to move it down into 
place on the next line.  
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16. Now, create your book. Click on your first page > drag the correct master page to 
this page to apply it. Click on the next page and do the same thing with the other 
master. If you add any pages, it automatically adds the correct right or left hand 
page associated with that master spread. If you want a different master page to be 

JOURNAL DESIGN BASICS - KRISTEN JOY SESSION 2, PAGE !25



applied to any page, all you have to do is drag the master you want to that page to 
apply it! 

So, we have four pages in our book, each a unique page on a Master Page 
spread. Select the four pages (drag through all four) > drag them down to the new 
page icon and just like that, you have 8 pages. Select all 8 pages > drag to new 
page icon and now you have 16 pages. Repeat, repeat, repeat. 

AND, if you need to make a change now, you change it on the master page and it 
changes every page in your book that has that master applied. Instantly.

To change the lightbulb to grayscale, open in Photoshop > 
Image > Mode > Grayscale > save. Now, when you look at 
the Links Panel in ID, you will see warning symbols indicating 
the original color image that is in all your pages has been 
changed. Select all three of the links in this panel > click the 
update link button > and just like that, the image has been 
changed to grayscale on every page in all documents in the 
book file! 

If you are just starting out and haven’t used Adobe products, do 
your layout in PowerPoint or Canva. This is okay. But, this is a 
business and you need to treat it like a business. 
At some point, you need to ramp up to 
professional-level software like InDesign. NOTE: 
For PC users, if creating in Powerpoint, your 
images will only be 96 pixels per inch, not 300 
and that is a problem for printing.
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NOTE 

There are SO MANY options for creating beautiful design layouts in InDesign. We did 
a lot in ID today, but this is not an InDesign class. If you’ve not used the software, or 
you have only a basic understanding of its features, it is worth it to you to take some 
classes and really learn how to use it. Occasionally there are free courses in 
both Photoshop and InDesign on CreativeLive.com. Or, sign up for one at 

your local community college and you may be able to use your student ID to 
get the student versions of Adobe’s Creative Cloud. 

http://CreativeLive.com
http://CreativeLive.com


Session 2 Homework 

1. Choose your color scheme
2. Play with fonts to see what you like
3. Draw out ideas on paper
4. Choose your software you want to use for your cover and interior layout. 

Implement it!
5. Check in on the Facebook Group with questions and support
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Session Q & A 

Q: How do you make broken lines for children learning to write
A: Underscore space > underscore space > underscore space

Q: I heard “they” own what you create in Photoshop
A: Have no idea what you are talking about. Photoshop is software and no one owns what 

you create with it except you

Q: Copyrights and Attribution for photos and quotes?
A: If you use photos or quotes that are public domain, no attribution is necessary. For quotes, 

brainyquote.com is a site full of fair use quotes and you can use these without attribution. If 
you use non-public domain, read the license to know if attribution is necessary. When you 
get an image with commercial use like an image from PhotoPin, there will be a piece of 
code or specifics for attribution on the page where you download the image. For example:

If using the image online, the entire html is copied and used in the link for the photo credit. 
If using the image in a book, you use the user name of the photographer (shown 
highlighted). You would say “photo by” and the person’s name.

Q: Do you create reusable templates in any of the software programs
A: Yes. I use previous books all the time and even copy/paste elements like copyright text

Q: What if you want to add page numbers without index or table of contents?
A: That is exactly what we did 

Q: Software you prefer for covers and interior layout?
A: InDesign for both

Q: Why not use Word, Publisher, Scrivener for layout?
A: Publisher is outdated and old and harder to use than InDesign. No way. Word is a word 

processing program, not a page layout program. It just screams “I self publish and don't 
know what I am doing.” There are elements of good layout that simply are not possible 
using word processing software and it would be a total waste of my time. Scrivener? I don’t 
know it well enough to use it for layout of a print book. It is fine for Kindle where you don’t 
need things to look pretty, but it is not a page layout program and I don’t know if it is 
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possible to make it do what I want because I don’t know it that well. If you want to learn 
Scrivener from an expert, go to learnscrivenerfast.com/kristen for a 20% discount for his 
top-level training

Q: “All Rights Reserved” — is this an American standard?
A: Yes. For international copyright, you need to check with local regulations. I am not an 

attorney and if you have questions about something specific, consult an attorney.

Q: What if I am feeling overwhelmed with all of this?
A: Keep going. Experience only comes from doing so make a decision to “do.”

Q: What is a good size to use for spacing between lines?
A: Every font is different so you have to work with it to see if it looks right. Print it out to test. 

Generally, you will probably use a font of 14-16 point;

Q: What about using shade of gray instead of black?
A: Use any color you want but remember that in print on demand or digital printing, lines and 

fonts are made by screening or little dots are used to make the shade of gray instead of a 
solid color like black. It isn’t a big deal but in some cases, the dots can be seen.

Q: Is it necessary in a journal to adhere to the convention of books starting on the right hand 
page as in chapter books? Is it okay to have two page spreads that start on left and 
continue on right.

A: Absolutely. That is one of the beautiful things about journals

Q: Is there an easy way to draw a grid like graph paper?
A: Yes. You could find a graph paper image and import it, make a table, draw lines, etc. There 

are many ways to do this, including some advanced techniques in InDesign.

Q: Is grayscale more expensive than black/white?
A: It is the same thing. Grayscale = black and white = no color

Q: In Powerpoint demo, what were the margins?
A: Listen to the replay. Page set up was 8 x 10 with standard margins

Q: Does the software have tutorials?
A: Adobe has an amazing range of tutorials for all their software. Check out Adobe TV for 

more videos than you can ever watch or you can look up anything on YouTube.
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http://learnscrivenerfast.com/kristen

